**TI Designs**

Hybrid RF and PLC Reference Design to Extend Network Coverage and Reliability

**TI Designs**

The importance of on-time response and monitoring in advanced metering infrastructure (AMI) and distribution automation networks increases demands on reliable communications. This TI Design addresses this issue by implementing a solution with both radio frequency (RF) and power line communication (PLC). This design can help improve network performance, reliability, capacity, and scalability. The CC13xx wireless microcontroller (MCU) acts as both the RF protocol processor and the host for the PLC processor, which results in additional cost-savings for the system design. This design is based on a proprietary RF solution to provide a reference for choosing various RF protocols and frequency bands as required in different markets. The *Hybrid Wireless M-Bus and G3-PLC Reference Design* (TIDC-HYBRID-WMBUS-PLC) implements a specific version of the hybrid RF plus PLC concept.

**Design Resources**

<table>
<thead>
<tr>
<th>Design Folder</th>
<th>Product Folder</th>
<th>Tools Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIDC-HYBRID-RF-PLC CC1310</td>
<td>Design Folder</td>
<td>Design Folder</td>
</tr>
<tr>
<td>F28PLC84</td>
<td>Product Folder</td>
<td>Product Folder</td>
</tr>
<tr>
<td>F28375S</td>
<td>Product Folder</td>
<td>Product Folder</td>
</tr>
<tr>
<td>F28M35H52C</td>
<td>Product Folder</td>
<td>Product Folder</td>
</tr>
<tr>
<td>AFE031</td>
<td>Product Folder</td>
<td>Tools Folder</td>
</tr>
<tr>
<td>AFE032</td>
<td>Product Folder</td>
<td>Tools Folder</td>
</tr>
<tr>
<td>TMDSPLCKITV4-CEN</td>
<td>Tools Folder</td>
<td>Tools Folder</td>
</tr>
<tr>
<td>CC1310DK</td>
<td>Tools Folder</td>
<td>Tools Folder</td>
</tr>
<tr>
<td>TI-PLC-G3-CENELEC-SN</td>
<td>Tools Folder</td>
<td>Tools Folder</td>
</tr>
<tr>
<td>CC13XX-SW</td>
<td>Tools Folder</td>
<td>Tools Folder</td>
</tr>
</tbody>
</table>

**Design Features**

- Improves Network Reliability Through Simultaneous Transmissions Over Wireless and PLC Networks
- Improves Network Capacity Through Spatial Multiplexing by Using RF and PLC Networks to Simultaneously Transmit Independent Data
- Improves Network Scalability by Acting as a Bridge Between RF and PLC Networks, Extending the Area Covered Within a Territory
- Fully Programmable Protocol Design Provides Various Options for RF and PLC Communication Protocols and Frequency Bands
  - PLC Protocols (PRIME, G3-PLC, and PLC-Lite) Over CENELEC, ARIB, and FCC Frequency Bands
  - RF Protocols (Wireless M-Bus, IEEE 802.15.4g FSK, and Long Range Mode) Over Sub-1 GHz (CC1310 or CC1350) and 2.4-GHz Frequency Bands (CC1350)

**Featured Applications**

- Distribution Automation
- Electricity Meters
- Smart Plugs
- Smart Grid Communications

---

Copyright © 2016, Texas Instruments Incorporated
An IMPORTANT NOTICE at the end of this TI reference design addresses authorized use, intellectual property matters and other important disclaimers and information.

1 System Description

This TI Design provides a reliable communication system solution with dual RF and PLC communications for end equipment of smart grid applications. This design is built on top of the existing TI PLC and RF solutions, which target at improving network performance and providing more features by combining the communication modems while keeping the advantages inherited from the existing PLC and RF solutions.

The programmable PLC design allows two options for the system design: one uses RF with a PLC full-stack based design (Figure 1), and one uses RF with a PLC lower-MAC stack based design (Figure 2). The former design takes full advantage of the embedded PLC network stacks, allowing multi-hop communications without additional effort in addition to the new features such as simultaneous transmissions, spatial multiplexing, PLC and RF repeaters, and support for two independent networks. The latter design allows the lower stacks (MAC or network layer) to control which physical layer (wireless or PLC) is used for each link over multi-hop networks. This capability cannot be supported by the former design.

Figure 1 shows the RF with a PLC full-stack based system architecture. The ARM® Cortex®-M3 processor in the CC1310 (or CC1350) Simplelink™ Wireless MCU is the CPU controlling both the RF and PLC links. For this design, the CC13xx Wireless MCU is connected to the C2000™ PLC MCU through UART to act as the PLC modem's external host processor. The PLC MCU is loaded with the complete PRIME or G3-PLC software stack. The wireless MCU also runs the system's host applications; for example, it simultaneously transmits packets on both networks or acts as a bridge between the different physical networks. The hybrid RF/PLC example project described in Section 4 implements this architecture with the full G3-PLC stack.

![Figure 1. System Architecture (RF With PLC Full-Stack)](image-url)
Figure 2 shows the RF with a PLC lower-MAC based system architecture. The only difference in this architecture is that the C2000 PLC device is loaded with PLC lower-MAC stack binary instead of full PLC stack. The benefit of this architecture is to allow building a single network layer to control both RF and PLC MAC or PHYs, which enables the network layer to select one of RF and PLC channels on a per-link basis over an entire multi-hop path. The decision algorithm of how to select one of the links (wireless or PLC) at the network layer can be implementation-specific. Note that this design is capable of building this type of architecture, but the software coming with this design does not provide any specific examples to work with this architecture.

The lower-MAC PLC software binary can be obtained from the G3-PLC DC or PRIME DC software package [5] [6]. The PLCLite, TI’s proprietary PLC solution, includes MAC and PHY only, which can be downloaded from the TI-PLC-PLCLITE product page [8].

![Figure 2. System Architecture (RF With PLC Lower-MAC Stack)](image-url)
2 Block Diagram

Figure 3 shows the block diagram of the design. The primary devices for this design are the CC1310, TMS320F28PLC84, and AFE031. The CC1310 includes two core processors: ARM Cortex-M0 for RF communication, and ARM Cortex-M3 for applications, network stacks, and host-level RF and PLC communication drivers. The TMS320F28PLC84 with the AFE031 (PLC analog front-end) is for PLC communication.

For this design, these devices were chosen because of the following:

- The CC1310 combines a flexible, ultralow-power RF transceiver with a powerful 48-MHz ARM Cortex-M3 microcontroller in a platform supporting multiple PHY (physical) layers and RF standards.
- The TMS320F28PLC84 provides optimized PLC OFDM performance with VCU and allows a programmable, flexible PLC design upgradable to different PLC solutions without hardware modification.
- The AFE031 analog front-end provides high reliability in PLC applications by monolithic integrated circuit with thermal and overcurrent protection.

![Figure 3. Block Diagram](image-url)
2.1 CC1310

The CC1310 is a member of the CC26xx and CC13xx family of cost-effective, ultralow-power, 2.4-GHz and Sub-1GHz RF devices. Its very low active RF, MCU current, and low-power mode current consumption provide excellent battery lifetime and allow operation on small coin-cell batteries and in energy-harvesting applications. The device is the first part in a Sub-1 GHz family of cost-effective, ultralow power wireless MCUs. The CC1310 combines a flexible, very low power RF transceiver with a powerful 48-MHz Cortex-M3 microcontroller in a platform supporting multiple physical layers and RF standards. A dedicated radio controller (Cortex-M0) handles low-level RF protocol commands that are stored in ROM or RAM, thus ensuring ultralow power and flexibility. The low-power consumption of the CC1310 does not come at the expense of RF performance; the CC1310 has excellent sensitivity and robustness (selectivity and blocking) performance. The CC1310 is a highly integrated, true single-chip solution incorporating a complete RF system and an on-chip DC-DC converter. Sensors can be handled in a very low-power manner by a dedicated autonomous ultralow-power MCU that can be configured to handle analog and digital sensors; thus, the main MCU (Cortex-M3) is able to maximize sleep time. The CC1310 power and clock management and radio systems require specific configuration and handling by software to operate correctly. This has been implemented in the TI RTOS, and it is therefore recommended that this software framework is used for all application development on the device. The complete TI-RTOS and device drivers are offered in source code free of charge. Figure 4 shows the CC1310 functional block diagram [1].
2.2 TMS320F28PLC84

The TMS320F28PLC84 PLC processors are optimized to meet the requirements for AMI networks in smart grid installations that use narrowband PLC in the CENELEC frequency band. The CENELEC band is defined to be 35 to 90 kHz. The F28PLC84 processor is designed to execute the entire PLC protocol stack for the supported industry standards. TI supplies these firmware libraries to execute on the F28PLC84 processor with no additional license fees or royalties. The F28PLC84 processor is also used in PLC data concentrators, which act as neighborhood-area collectors of electricity usage information from multiple end nodes. The F28PLC84 processors are optimized to work with the AFE031 analog front-end for PLCs. The AFE031 is an integrated analog front-end for narrowband PLCs that are capable of driving a transformer-coupled connection to the AC mains power line. It is ideal for driving high-current, low-impedance lines driving up to 1.9 A into reactive loads. The AFE031 is compliant to CENELEC A, B, C, and D (EN50065-1, EN50065-2, EN50065-3, EN50065-7) frequency bands. Figure 5 shows the TMS320F28PLC84 functional block diagram [2].

Figure 5. TMS320F28PLC84 Functional Block Diagram [2]
The AFE031 is a low-cost, integrated, PLC analog front-end device that is capable of capacitive- or transformer-coupled connections to the power line while under the control of a DSP or microcontroller. It is ideal for driving low-impedance lines that require up to 1.5 A into reactive loads. The integrated receiver is able to detect signals down to 20 \( \mu V_{RMS} \) and is capable of a wide range of gain options to adapt to varying input signal conditions. This monolithic integrated circuit provides high reliability in demanding PLC applications.

The AFE031 transmit power amplifier operates from a single supply in the range of 7 to 24 V. At maximum output current, a wide output swing provides a 12-V_{PP} (I_{OUT} = 1.5 A) capability with a nominal 15-V supply. The analog and digital signal processing circuitry operates from a single 3.3-V power supply.

The AFE031 is internally protected against over temperature and short-circuit conditions. It also provides an adjustable current limit. An interrupt output is provided that indicates both current limit and thermal limit. There is also a shutdown pin that can be used to quickly put the device into its lowest power state.

Through the four-wire serial peripheral interface, or SPI, each functional block can be enabled or disabled to optimize power dissipation. The AFE031 is housed in a thermally-enhanced, surface-mount Power PAD package (QFN-48). Operation is specified over the extended industrial junction temperature range of –40°C to 125°C. Figure 6 shows the AFE031 functional block diagram [3].

Figure 6. AFE031 Functional Block Diagram [3]
3 Getting Started Hardware

The hybrid RF and PLC communications design is built with two standard EVMs: the CC1310DK (http://www.ti.com/tool/CC1310DK) and the TMDSPLCKITV4-CEN (http://www.ti.com/tool/tmdsplckitv4-cen), shown in Figure 7 and Figure 8, respectively. For PLC, this TI Design is configured as CENELEC-A band in software with the TMDSPLCKITV4-CEN platform. Depending on user applications, the TIDM-SOMPLC-FCC (http://www.ti.com/tool/TIDM-SOMPLC-FCC) or the TMDSPLCKITV4-ARIB (http://www.ti.com/tool/TIDM-SOMPLC-ARIB) can be also used with the CC1310DK. Similarly, the CC1310 can be replaced with the CC1350 or other CC wireless MCUs with some modification on the example software provided with the TI Design.

Figure 7. CC1310DK

Figure 8. TMDSPLCKITV4-CEN
3.1 Hybrid RF/PLC EVM Configuration

The major hardware modification to build the hybrid RF/PLC module is to connect UART pins between RF and PLC EVM: UART_TX, UART_RX, and GND. Figure 9 and Figure 10 show UART pin connections between the TMDSPLCKITV4 and CC1310DK. The M3:P2-12 (PLC_SCIA_TX) pin (Figure 9) is connected to EM_UART_RX in P412 (Figure 10) in the CC1310DK docking board, and M3:P2-14 (PLC_SCIA_RX) (Figure 9) to EM_UART_TX in P412 (Figure 10). One of the GND pins in the TMDSPLCKITV4 EVM, shown in Figure 9, is connected to GND in P412 (Figure 10).

![Figure 9. UART Pins on TMDSPLCKITV4](image)

![Figure 10. UART Pins on CC1310DK Docking Board (SmartRF06 Evaluation Board)](image)

As shown in Figure 11, additional configuration change is SW2 position to OFF. Turning off the SW2 blocks UART communication with the mini-USB port in TMDSPLCKITV4. Thus, it allows the M3 module to communicate with external device through UART without any interrupts.

![Figure 11. SW2 Position in TMDSPLCKITV4 EVM](image)
4 Getting Started Firmware

This TI Design provides a software example (Hybrid_RF_PLC_project, www.ti.com/tool/TIDC-HYBRID-RF-PLC), including applications for simultaneous transmissions, RF and PLC repeaters, and RF and PLC communication drivers. This section covers details of the example software architecture, followed by how to build and flash the example project using Code Composer Studio™ (CCS).

The first step to building the software example is to install CCS v6.1.2 (or above) with the latest software update (by selecting Help → Check for Updates in the CCS top menu) and TI-RTOS (http://www.ti.com/tool/cc13xx-sw). The correct TI-RTOS version to install can be checked in the RTSC menu (by right-clicking on the example CCS project and then navigating to Property → General). After installing CCS and TI-RTOS, the SimpleLink wireless MCU examples can be made visible by selecting View → Resource Explorer in the CCS top menu as shown in Figure 12.

The baseline project for the example is “RF EasyLink RX” project. The baseline project was modified by integrating some codes from “RF EasyLink TX” and “UART Echo” example projects, available in SimpleLink wireless MCU examples.

![Figure 12. RF EasyLink RX Project in CCS TI Resource Explorer](image)

Figure 12 shows the CCS property for the example project. Make sure that the CCS property to build the example project is identical to this.

![Figure 13. Hybrid RF PLC Project CCS Property](image)

Figure 13 shows the CCS property for the example project. Make sure that the CCS property to build the example project is identical to this.
4.1 Hybrid_RF_PLC_project Example

The Hybrid_RF_PLC_project example runs based on TI-RTOS in the ARM Cortex-M3. For PLC communication, the default configuration in the example is set to CENELEC-A, TMR ON, and the TX level of 0x20 (maximum). For RF communication, the example is set to a 50-kbps FSK mode over a 868-MHz frequency band. The major code changes on top of the EasyLink RX project are included in the hybrid_main.c and g3PLC.c/h files.

To run the example project with another PLC product based on the F28375S (FCC) or F28M35x (ARIB), change the following line of code in the init_plcHandler() (in g3PLC.c) to TONEMASK_FCC_FULL_BAND or TONEMASK_FCC_ARIB_54, respectively. In addition, the TX power level and TMR configuration can be changed in the same function.

```c
plcHandle.g3ToneMaskSelection = TONEMASK_CENELEC_A_36;
```

In addition to RF and PLC communication drivers, the example project runs simultaneous transmissions (sending data to both RF and PLC channels) and the RF and PLC repeaters (passing received RF (or PLC) data to PLC (or RF) link). Depending on end-product requirements, each feature can be disabled by simply disabling the macros ("SIMULTANEOUS_RF_PLC" and "RF_PLC_REPEATER") defined in hybrid_main.c.

Figure 14 shows the overall software architecture of the hybrid RF/PLC example, which consists of five tasks: uartRxTask, PLCStateMachineTask, RFTxTask, PLCTxTask, and applicationTask. This project is provided as a working example to be used for baseline software on customer-specific application development.

![Figure 14. Hybrid RF/PLC Example Software Architecture](image_url)
4.1.1 uartRxTask

The uartRxTask processes PLC host messages received from the C2000 PLC device. The task waits for a 6-byte PLC host message header that contains the host message type, payload length, and header CRC. If the CRC passes, the task extracts remaining bytes including payload CRC, payload sub-header, and payload. If the payload CRC passes, then the task passes the received data to the corresponding tasks through mailbox.

4.1.2 PLCStateMachineTask

The PLCStateMachineTask maintains G3-PLC service node state machine. When power is on, the PLCStateMachine task starts to initialize G3-PLC with the default configuration and to join the G3-PLC network once G3-PLC DC is detected. Once all steps are successful, the task changes the state machine to NORMAL state, which allows the PLCTxTask to start data transmissions.

The details of the G3-PLC host message sequences can be found in Section 4.2, and this example is implemented in all procedures except for the keep-alive mechanism and firmware upgrade.

4.1.3 RFTxTask

The RFTxTask waits for the mailbox message of "SEND_RF_DATA". Once the task receives the mailbox message, it sends the data over the RF transmission path with a given configuration and then changes back to the receive state.

4.1.4 PLCTxTask

The PLCTxTask waits for the mailbox messages of "SEND_PLC_DATA" and "RETX_PLC_DATA". If the task receives one of the mailbox messages, it sends the data over UART to the PLC C2000 device for PLC transmissions, and then copies the data into PLC_HoldQueue to handle re-transmissions. The RETX_PLC_DATA message can be received when the transmission fails due to PLC communication errors or the task does not receive confirmation message until timeout. When retransmission happens, the task simply sends the data in the PLC_HoldQueue through UART.

4.1.5 applicationTask

The applicationTask emulates application data source. This task creates 10-byte random data and sends a mailbox message with data to RFTxTask and PLCTxTask every 5 seconds for simultaneous transmissions.

4.1.6 LED Configuration

The example project has activated four LEDs to trace software activities. Table 1 summarizes the LED number mapping to the specific software activity. The LED configuration works only for the CC1310DK EVM.

<table>
<thead>
<tr>
<th>LED NUMBER</th>
<th>BEHAVIOR MAPPING TO SOFTWARE ACTIVITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ON when joined to PLC network</td>
</tr>
<tr>
<td>2</td>
<td>Toggling for PLC state machine change</td>
</tr>
<tr>
<td>3</td>
<td>Toggling for PLC TX/RX</td>
</tr>
<tr>
<td>4</td>
<td>Toggling for RF TX/RX</td>
</tr>
</tbody>
</table>
4.2 G3-PLC Service Node Host Message Sequences

This section details the G3-PLC host message sequences to run as G3-PLC service node.

4.2.1 Initialization State

Table 2. Host Message Sequence (Initialization)

<table>
<thead>
<tr>
<th>SEQ</th>
<th>HOST MSG</th>
<th>MSG TYPE</th>
<th>PARAMETERS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Load system configuration</td>
<td>0x0C</td>
<td>Config type: 0x0001&lt;br&gt;Diag port/host port: SCI-A (0x00)</td>
</tr>
<tr>
<td></td>
<td>(Port configuration)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Load system configuration</td>
<td>0x0C</td>
<td>Config type: 0x0003&lt;br&gt;Device mode: 0x0000 (G3 normal mode)</td>
</tr>
<tr>
<td></td>
<td>(System configuration)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Load system configuration</td>
<td>0x0C</td>
<td>Config type: 0x0008&lt;br&gt;COH: 0 (OFF)&lt;br&gt;TMR: 1 (ON if TMR is used)&lt;br&gt;G3 long address: unique ID*&lt;br&gt;Note that the G3 long address should be little-endian order. As an example, 0x11 22 33 44 55 66 77 88 if your long address is 0x88 77 66 55 44 33 22 11.</td>
</tr>
<tr>
<td></td>
<td>(G3 configuration)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>SHUT_DOWN</td>
<td>0x05</td>
<td>Reset type: soft reset&lt;br&gt;2-second delay after receiving SHUT_DOWN.confirm</td>
</tr>
<tr>
<td>5</td>
<td>SET_INFO (G3 PHY TX parameters)</td>
<td>0x04</td>
<td>Info type: 0x0002&lt;br&gt;Band selection: CENELEC/FCC/ARIB&lt;br&gt;TX level: 0x20 (maximum)&lt;br&gt;Modulation: Any value in [4]&lt;br&gt;Tonemask: CEN A 36 (for CENELEC)</td>
</tr>
<tr>
<td>6</td>
<td>SET_INFO (G3 PHY RX parameters)</td>
<td>0x04</td>
<td>Info type: 0x0003&lt;br&gt;Band selection: CENELEC/FCC/ARIB&lt;br&gt;COH/BLI: 0&lt;br&gt;Gain value: 0 (ignored if AGC is set to 1)&lt;br&gt;Tonemask: CEN A 36 (for CENELEC)&lt;br&gt;The tonemask value should be the same as TX.</td>
</tr>
<tr>
<td>7</td>
<td>SET_MAC_PIB</td>
<td></td>
<td>adpLOADNGSequenceNumber (= (previous value + offset1)%0xFFFF)&lt;br&gt;macFrameCounter (= (previous value + offset2)%0xFFFFFFFF)&lt;br&gt;Note that the initial values are set to 0, and the offset calculation is given in Section 4.2.2.</td>
</tr>
<tr>
<td>8</td>
<td>Discover</td>
<td>0x12</td>
<td>Discover type: 0x00 - Network discover&lt;br&gt;Duration: 12 (in seconds)</td>
</tr>
<tr>
<td>9</td>
<td>Attach</td>
<td>0x10</td>
<td>PAN ID: CoordPANId from the PAN Descriptor&lt;br&gt;LBA address: CoordAddr from the PAN descriptor</td>
</tr>
</tbody>
</table>

Note: All reserved fields should be set to zero.

To avoid collisions between multiple nodes in the discovery stage, it is strongly recommended to add random back-off before sending Discover.request.

Step 7 is required when the DC assigns static short address for each service node.
4.2.2 Normal State

After the host receives ATTACH.confirm (SUCCESS), it is ready state to send and receive data.

4.2.2.1 Data Transfer

Table 3. Data Transfer Message Configuration

<table>
<thead>
<tr>
<th>SEQ</th>
<th>HOST MSG</th>
<th>MSG TYPE</th>
<th>PARAMETERS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DATA_TRANSFER</td>
<td>0x00</td>
<td>NSDU Handle: random value</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SEC: 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>QoS: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>D-route:1 (This will automatically set up route to the destination whenever it is needed.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>L_SDU data: IPv6 packet</td>
</tr>
</tbody>
</table>

Set D-route flag to 1, which allows the DSP to find a route to the destination if the route is not valid. The L_SDU data should be IPv6 packet. An example of UDP over IPv6 packet is given below.

```
60 00 00 00 00 23 11 08 FE 80 00 00 00 00 00 00 00 00 00 00 74 55 00 FF FE 00 00 00 FE 80 00 00 00 00 00 00 00 74 55 00 FF FE 00 00 01 00 00 00 00 00 00 01 00 00 00 00 00 00 00 00 00 00 00 00 00 03 00 00 31 31 31
```

- IPv6 header (40-byte in red-color with underline)
  - Next header: 17 (=UDP)
  - Payload length: 35
  - Hop limit: 8
  - Source address: FE80:0000:0000:0000:7455:00FF:FE00:0000
  - Destination address: FE80:0000:0000:0000:7455:00FF:FE00:0001
- UDP header (8-byte in blue-color with italic)
  - Source port: 0x0000
  - Destination port: 0x0000
  - Length: 35 (Note that the length should be the same as that of the IPv6 header)
  - CRC: 0x0000 (If the CRC is zero, UDP checksum will be ignored)
- Application payload
  - A0 AA 00 00 00 00 00 00 01 00 00 00 01 00 00 00 01 00 00 00 03 00 00 31 31 31
4.2.2.2  Keep-Alive Mechanism

The keep-alive mechanism is for the host to check if the DSP is alive or not. For this purpose, probe the PIBs given in Table 4. The host requires tracking of the PIB values and setting updated values (= the previous PIB value + offset) to the PIBs in the initialization routine when reset happens.

The ping interval can be implementation specific. The offset value depends on the ping interval. As an example, if the host set the ping interval to 2 minutes for macFrameCounter and the last update for the value is 100, then the macFrameCounter should be set to 1300 (= 2 minutes × 600 per minute + 100) when reset happens.

### Table 4. PIB for Keep-Alive

<table>
<thead>
<tr>
<th>ATTRIBUTE</th>
<th>PIB ID</th>
<th>LENGTH</th>
<th>OFFSET</th>
</tr>
</thead>
<tbody>
<tr>
<td>adpLOADNGSequenceNumber</td>
<td>0xa5</td>
<td>2</td>
<td>10 per minute</td>
</tr>
<tr>
<td>macFrameCounter</td>
<td>0x77</td>
<td>4</td>
<td>600 per minute</td>
</tr>
</tbody>
</table>

Figure 15. Keep-Alive Mechanism
4.2.3 Error Handling

If the host does not receive confirmation from the DSP within the timeout given in Table 5, the host needs to retry until it reaches MaxRetryCnt (implementation-specific). If all the trials fail, hard reset to recover from the stage. The details are given in Figure 16.

**NOTE:** The host application has to wait until it receives a confirmation message to transmit the next message. The timeout value given in Table 5 can be used to indicate that the confirmation is lost.

<table>
<thead>
<tr>
<th>MESSAGE</th>
<th>TIMEOUT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attach.request</td>
<td>$T_1 = \text{adpLBAMAXAttempts} \times \text{adpJoinWaitTime}$ (for example, 360 seconds with the default PIB setting) Note that changing the PIB values should apply to the timeout calculation.</td>
</tr>
<tr>
<td>Data transfer</td>
<td>$T_2 = 150$ seconds (CENELEC) or $90$ seconds (FCC)</td>
</tr>
<tr>
<td>Other messages</td>
<td>$T_3 = 5$ seconds</td>
</tr>
</tbody>
</table>

**Figure 16. Recovery and Timeout Mechanism**

4.2.4 Firmware Upgrade

The details of host message exchanges for a firmware upgrade are described in Section 2.4 of the TI-PLC-G3-GENELC-SN software package *TI_G3_host_msg.pdf* [4].
4.3 **Build Hybrid_RF_PLC_project Example Using CCS**

The example project can be built with CCS IDE v6.1.2 (or above). Open the project file in the directory of Hybrid_RF_PLC_project/ and build the project with the build configuration of Debug. The screen capture is shown in Figure 17. Once successfully compiled, the binary file (Hybrid_RF_PLC_project_debug.out) can be generated in Hybrid_RF_PLC_project/Debug/.

![Figure 17. Build Hybrid_RF_PLC Project](image)

4.4 **Flashing Binaries Using CCS**

This section presents a step-by-step procedure to flash software binary to F28PLC84 (for G3-PLC) and CC1310 (for Hybrid RF/PLC application) devices, which is required to run the Hybrid RF/PLC node.

4.4.1 **Flashing Hybrid RF/PLC Example Binary to CC1310 Using CCS**

This section covers how to flash the Hybrid RF/PLC example binary on the CC1310 using CCS.

1. Connect the USB cable to CC1310DK.
2. Select View → Target Configurations and create a new target configuration as shown in Figure 18.

![Figure 18. Target Configuration for CC1310](image)
3. Launch the target configuration and connect to the Cortex_M3_0 core as shown in Figure 19.

![Figure 19. CCS Debug for CC1310](image)

4. Select Run → Load → Load Program and flash the "Hybrid_RF_PLC_project_debug.out" binary in the directory of Hybrid_RF_PLC_project\Debug\.

4.4.2 Flashing PLC Binary to TMS320F28PLC84

Find the step-by-step procedure in Section 7.1 (if using the XDS100 and CodeSkin to program the F28PLC84 MCU) or Section 7.2 (if using CCS and JTAG emulator to program the F28PLC84 MCU) in the TIDM-SOMPLC-G3-CENELEC TI design guide [7]. The latest G3-PLC software can be obtained from TI-PLC-G3-CENELEC-SN-F28PLC84 (http://www.ti.com/tool/ti-plc-g3-cenelec-sn).
5 Hybrid RF/PLC Test

The goal of the Hybrid RF/PLC test is to show simultaneous transmissions and RF-to-PLC repeater features with a 3-node set-up: one RF only, one PLC only, and one Hybrid RF/PLC node.

5.1 Test Setup

To run the Hybrid RF/PLC test, it is required to have the CC1310DK (http://www.ti.com/tool/CC1310DK) and the TMDSPLCKITV4-CEN (http://www.ti.com/tool/TMDSPLCKITV4-CEN). Find both EVMs in the TI store (https://store.ti.com/). In addition, Table 6 summarizes the additional tools and software required to run the Hybrid RF/PLC test.

Table 6. Required Tools for Hybrid RF/PLC Test Setup

<table>
<thead>
<tr>
<th>DEVICE</th>
<th>EVM</th>
<th>HW MODIFICATION?</th>
<th>FLASH Firmware?</th>
<th>GUI TOOL?</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF only</td>
<td>CC1310DK</td>
<td>No</td>
<td>No</td>
<td>Yes (SmartRF Studio(1))</td>
</tr>
<tr>
<td>PLC only</td>
<td>TMDSPLCKITV4-CEN</td>
<td>No</td>
<td>Yes (Section 4.4.2)</td>
<td>Yes (Zero-configuration GUI(2))</td>
</tr>
<tr>
<td>Hybrid RF/PLC</td>
<td>CC1310DK, TMDSPLCKITV4-CEN</td>
<td>Yes (Section 3)</td>
<td>Yes (Section 4.4.1 and Section 4.4.2)</td>
<td>No (Running in standalone mode)</td>
</tr>
</tbody>
</table>

(1) SmartRF Studio is used to trace RF RX data and to send RF data, which can be obtained from http://www.ti.com/tool/smartrftm-studio
(2) Zero-configuration GUI is use to run PLC node as mini-DC to start G3-PLC network. The G3-PLC software package (http://www.ti.com/tool/ti-plc-g3-cenelec-en) installs the GUI automatically.

5.2 Running Hybrid RF/PLC Test

Figure 20 shows the 3-node test setup. The RF only node runs with the SmartRF™ software tool and the PLC only node runs with zero-configuration graphical user interface (GUI) tool. The Hybrid RF/PLC node runs in standalone mode.

![Hybrid RF/PLC Test Setup](image)

For the Hybrid RF/PLC test, the PLC only node is configured as the G3-PLC mini-DC node. The RF only node can run as the PACKET_RX mode to capture RF packets or the PACKET_TX mode to transmit RF packets. The PACKET_RX mode shows simultaneous transmissions from the Hybrid RF/PLC node, and the PACKET_TX mode shows RF-to-PLC repeater functionality on the Hybrid RF/PLC node.

When the Hybrid RF/PLC node starts, it will try to join to the PLC mini-DC (PLC only node) as the G3-PLC service node. The RF is running only PHY, so no joining is required. Once joined to the PLC network, the Hybrid RF/PLC node starts to send out 10B data to both RF and PLC nodes every 5 seconds. The PLC only and RF only node can capture the packet receptions through the GUI. In addition, the RF only or the PLC only nodes can generate data to show the RF-to-PLC repeater functionality on the Hybrid RF/PLC node. The Hybrid RF/PLC node can forward data received from one end (the RF only or PLC only node) to the other end. The receptions on the other end can be captured with the GUI tool.
5.2.1 Test Procedure

This section covers the step-by-step procedure to run the Hybrid RF/PLC test.

1. Start the PLC only node as mini-DC (Steps 1 to 5 in Section 5.2.2).
2. Start the RF only node with SmartRF Studio and set to Packet RX mode (Steps 1 to 3 in Section 5.2.3).
3. Turn on the Hybrid RF/PLC node to start in standalone mode. To power cycle the RF EVM in the Hybrid RF/PLC node, switch both “Source” and “Power” from OFF (or BAT) to ON (or USB) position.
4. Once the Hybrid RF/PLC node is joined to the PLC network, an indication will show up in the mini-DC pop-up window (Step 6 in Section 5.2.2).
5. Check the simultaneous transmissions from Hybrid RF/PLC node on the GUI for the PLC and RF nodes (Step 7 in Section 5.2.2 for PLC and Step 3 in Section 5.2.3 for RF).
6. To show the RF-to-PLC repeater feature, the PLC only node starts to transfer data (Step 8 in Section 5.2.2). Then, the RF RX data will be shown in SmartRF Studio window (Step 3 in Section 5.2.3).
7. To show the RF-to-PLC repeater feature, start to send RF data (Step 4 in Section 5.2.3). Then, the PLC RX data will be captured in the GUI log window (Step 7 in Section 5.2.2).

5.2.2 PLC Only Node Setup

This section covers how to run the PLC only node as mini-DC with the GUI.

1. Connect the PLC only node to the PC and open intermediate GUI.
2. Set a unique long address for each device by using “Set System Config”.

![Image of Set System Configuration GUI]

Figure 21. Set System Configuration
3. Turn on "Log Raw Message Data" to see all the raw data exchanged between the GUI and C2000 PLC.
4. Start the device as mini-DC by selecting Functions → Start Base Node.

5. In the pop-up window of the G3 base node, click "Start Network".
6. Once the Hybrid RF/PLC node is joined, the IPv6 information for the joined node is visible.

![Image of G3 Base Node Window showing IPv6 information for joined node]

**Figure 26. Joining Node Information in the G3 Base Node Window**

7. Go to the log window to trace all the received data (G3 Data Transfer Indication).

![Image of Log Window showing G3 Data Transfer Indication]

**Figure 27. G3 Data Transfer Indication on the Log Window**
8. Set both "Min Data Packet Size" and "Max Data Packet Size" to less than 70B and with "Cycle" to 1 as shown in Figure 28. In this capture, the packet size is set to 50B with cycles of 1. Then, send PLC data by selecting "Start Test".

Figure 28. Start Test in the G3 Base Node Window
5.2.3 RF Only Node Setup

1. Connect the RF only node to the PC and open SmartRF Studio.
2. Select the device in the list of connected devices on the bottom of the window.

![SmartRF Studio 7](image)

Figure 29. SmartRF™ Studio 7
3. To run Packet RX mode, select the "Packet RX" tab and click "Start".

4. To run Packet TX mode, select "Packet TX" tab, change the packet count to 1, and then click "Start". Instead of using random data, it may be easier to trace data by sending a text message to check "Text". Figure 31 shows an example to send a text message of "11111".
5.3 **Hybrid RF/PLC Test Results**

This section shows the Hybrid RF/PLC test results to verify simultaneous transmissions and RF-to-PLC repeater functionality.

**Figure 32** shows the simultaneous transmission test results with a 3-node setup. The Hybrid RF/PLC node starts to send 10B packets with intervals of 5 seconds to both RF and PLC nodes once PLC completely joins the process. The zero-configuration GUI on the PLC only node shows 10B packet reception (G3 Data Transfer.Indication) in the log window (top of **Figure 32**), and at the same time the RF only node receives the same packet (10B packet with RF sub-header information) in the Packet RX window (bottom of **Figure 32**).
**Figure 33** shows test results for PLC-to-RF repeater functionality. For the test, the PLC node sent a 50B UDP/IPv6 packet, meaning that the total packet size is 98B (50B payload + 40B IPv6 header + 8B UDP header). The zero-configuration GUI shows the packet transmission (G3 Data Transfer.Request) in the GUI. As a result, the Hybrid RF/PLC node forwarded the received PLC data to the RF link. Finally, the RF node shows the packet reception on the Packet RX window at the timestamp of 15:32:38.905. Note that, for this testing, the packet size sent by the PLC should be limited up to 70B because of the size limitation by the pre-programmed RF software. The RX packet size can be increased by flashing a new RF RX example binary with the increased maximum RX packet size.

![Figure 33. PLC-to-RF Repeater](image)
Figure 34 shows test results of the RF-to-PLC repeater. For the test, the RF node sent a 5B text message. Once the 5B packet is received at the Hybrid RF/PLC node, the node passes the received data to the PLC link. The zero-configuration GUI shows the packet reception (in forms of G3 Data Transfer Indication) in the zero-configuration GUI (top in Figure 34). The received packet at PLC includes 6B of information (5B message + 1B sub-header inserted by the RF transmitter).
6  Design Files

6.1  Schematics
    To download the schematics, see the design files at TIDC-HYBRID-RF-PLC.

6.2  Bill of Materials
    To download the bill of materials (BOM), see the design files at TIDC-HYBRID-RF-PLC.

6.3  Layout Prints
    To download the layer plots, see the design files at TIDC-HYBRID-RF-PLC.

6.4  Gerber Files
    To download the Gerber files, see the design files at TIDC-HYBRID-RF-PLC.

6.5  Assembly Drawings
    To download the assembly drawings, see the design files at TIDC-HYBRID-RF-PLC.
Software Files

To download the software files, see the design files at TIDC-HYBRID-RF-PLC.

References

2. Texas Instruments, *TMS320F28PLC8x Power Line Communications (PLC) Processors*, TMS320F28PLC8x Datasheet (SPRS802)
3. Texas Instruments, *Powerline Communications Analog Front-End, AFE031 Datasheet* (SBOS531)

Terminology

PLC—Power line communication
RF—Radio frequency
TMR—ToneMap request
DC—Data concentrator
VCU—Viterbi/complex math unit
AMI—Advanced metering infrastructure
AFE—Analog front-end

About the Author

WONSOO KIM is a system engineer at Texas Instruments, where he is responsible for driving system solutions for Smart Grid applications, defining future requirements in TI’s product roadmap, and providing system-level support and training focusing on communication software and systems for Smart Grid customers. He received the Ph.D. degree in electrical and computer engineering from the University of Texas at Austin, Austin, TX.
### Revision A History

NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

<table>
<thead>
<tr>
<th>Changes from Original (April 2016) to A Revision</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Changed from preview page</td>
<td>1</td>
</tr>
</tbody>
</table>

---
IMPORTANT NOTICE FOR TI REFERENCE DESIGNS

Texas Instruments Incorporated (‘TI”) reference designs are solely intended to assist designers ("Designer(s)”) who are developing systems that incorporate TI products. TI has not conducted any testing other than that specifically described in the published documentation for a particular reference design.

TI’s provision of reference designs and any other technical, applications or design advice, quality characterization, reliability data or other information or services does not expand or otherwise alter TI’s applicable published warranties or warranty disclaimers for TI products, and no additional obligations or liabilities arise from TI providing such reference designs or other items.

TI reserves the right to make corrections, enhancements, improvements and other changes to its reference designs and other items. Designer understands and agrees that Designer remains responsible for using its independent analysis, evaluation and judgment in designing Designer’s systems and products, and has full and exclusive responsibility to assure the safety of its products and compliance of its products (and of all TI products used in or for such Designer’s products) with all applicable regulations, laws and other applicable requirements. Designer represents that, with respect to its applications, it has the necessary expertise to create and implement safeguards that (1) anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that might cause harm and take appropriate actions. Designer agrees that prior to using or distributing any systems that include TI products, Designer will thoroughly test such systems and the functionality of such TI products as used in such systems.

Designer may not use any TI products in life-critical medical equipment unless authorized officers of the parties have executed a special contract specifically governing such use. Life-critical medical equipment is medical equipment where failure of such equipment would cause serious bodily injury or death (e.g., life support, pacemakers, defibrillators, heart pumps, neurostimulators, and implantables). Such equipment includes, without limitation, all medical devices identified by the U.S. Food and Drug Administration as Class III devices and equivalent classifications outside the U.S.

Designers are authorized to use, copy and modify any individual TI reference design only in connection with the development of end products that include the TI product(s) identified in that reference design. HOWEVER, NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information published by TI regarding third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement thereof. Use of the reference design or other items described above may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

TI REFERENCE DESIGNS AND OTHER ITEMS DESCRIBED ABOVE ARE PROVIDED “AS IS” AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING THE REFERENCE DESIGNS OR USE OF THE REFERENCE DESIGNS, INCLUDING BUT NOT LIMITED TO ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY DESIGNERS AGAINST ANY CLAIM, INCLUDING BUT NOT LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS AS DESCRIBED IN A TI REFERENCE DESIGN OR OTHERWISE. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL, COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THE REFERENCE DESIGNS OR USE OF THE REFERENCE DESIGNS, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

TI's standard terms of sale for semiconductor products (http://www.ti.com/sc/docs/stdterms.htm) apply to the sale of packaged integrated circuit products. Additional terms may apply to the use or sale of other types of TI products and services.

Designer will fully indemnify TI and its representatives against any damages, costs, losses, and/or liabilities arising out of Designer’s non-compliance with the terms and provisions of this Notice.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2016, Texas Instruments Incorporated